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File Menu

The File Menu Options allow you to manage Btrieve and description files. 

New Sets the current contents of the Information Editor to the default values.
Open... Opens and loads file information from a Btrieve or Description file.
Close Closes the Information Editor Window.
Create Creates a new file using the current file name and type.
Create As... Creates a new file using a different file name and type.
Set / Clear Owner... Set or drop an owner name on a Btrieve file.
Exit Exits Btrieve File Manager

Related topics
Information Editor Window 



Index Menu

Create / Drop Allows you to create and drop indexes on an existing Btrieve
file.

Related topics
Create / Drop Index Dialog 



Data Menu

The Data Menu Options allow you to manipulate data between Btrieve and sequential files.

Load Allows you to copy data from a sequential file to a Btrieve file.
Copy Allows you to copy data from one Btrieve file to another Btrieve file.
Save Allows you to copy data from a Btrieve file to a sequential file.

Help Menu

The Help Menu Options allow you to access the help system.

Getting Help Explains how to access the help system.
Help Index Displays the help index. 
Using Microsoft Windows Help Explains how to use the MS Windows help system.
About... Displays the About Dialog .

Information Editor Window

The Information Editor Window allows the user to easily enter, edit, and view Btrieve file / key information. 
Once complete, the information can be used to create Btrieve files, indexes, and description files. The 
information in the window is grouped into three sets of controls:

Miscellaneous File Information Information about the Btrieve or description file not part of 
the file or key specifications.

File Specification Attributes of a Btrieve file related to file and record structure,
number of keys, data compression, etc...

Key Specification Attributes of a Btrieve file related to a specific key or a 
segment within a key.

Much of the information in the editor is interrelated. These relationships are often indicated by enabling or 
disabling controls. This approach not only helps the user understand the relationships between the 
various Btrieve file and key attributes; it also helps to prevent him from entering inconsistent information.
Here are a few examples:

All    key and segment controls (except the create key button) are disabled if no key or key segment is 
selected.
The Blank Truncation control is disabled unless the Variable Records control is checked. 
The ACS information    button is disabled unless the current segment's Use ACS control is checked. 

Related topics
Description file comments dialog 
Alternate Collating Sequence information dialog 
Save report dialog 



Open File Dialog

This dialog is a standard file browse dialog which allows the user to select an existing Btrieve or 
description file. The Btrieve File Manager then displays the file / key information for the selected file in the 
Information Editor. All files in the current directory with the extension of the last file opened are shown 
initially. Below is a description of each of the dialog's controls.

File Name Specifies the file name to open

File List Displays list of files in current directory corresponding to search 
pattern in file name control

Directories Displays the current working directory

Directories List Displays hierarchical view of directory structure

Drive List Allows user to change current drive letter

Ok Button The Btrieve File Manager attempts to open the specified file and 
display the file's file and key information in the Information Editor 
Window.

Cancel Button Closes the dialog without opening a file.

CreateAs Dialog

This dialog is a standard file browse dialog which allows the user to specify the name and type
of the    file being created.    The file name and type used to last open or create a file are shown initially 
along with all files in the current directory. Below is a description of each of the dialog's controls.

File Name Specifies the name of the file to create

File List Displays list of files in current directory corresponding to search pattern in file
name control.

Directories Displays the current working directory

Directories List Displays a hierarchical view of the directory structure

Drive List Allows user to change current drive letter

File Type This group box allows you to select the type of file to be created by the 
Btrieve File Manager.

Btrieve When selected, a Btrieve file will be created

Description When selected, a description file will be created

Index Only When checked, only the currently selected key specification from the 
Information Editor Window will be saved to the description file. This allows 
you to save information for a key which you may use later to create a new file
or key.



Ok Button Closes the dialog and returns the specified file name to the applications

Cancel Button Closes the dialog without returning a file name



Save Report Dialog

This dialog is a standard file browse dialog which allows you to specify the name of the report file to 
create. You can also choose to view the report file after it has been created. All files in the current 
directory are shown initially. Below is a description of each of the dialog's controls.

File Name Specifies the name of the report file to create

File List Displays list of files in current directory corresponding to search pattern in file
name control.

Directories Displays the current working directory

Directories List Displays a hierarchical view of the directory structure

Drive List Allows user to change current drive letter

View File When checked, the report file will be displayed in a window after it has been 
created.

Ok Button Closes the dialog and returns the specified file name to the applications

Cancel Button Closes the dialog without returning a file name

Create / Drop Index Dialog

This dialog allows the user to create and drop Btrieve indexes. Below is a description of each of the 
dialog's controls.

File Names
Btrieve File Specifies the name of the existing Btrieve file to which you wish to 

add or drop indexes. 

External Index File Specifies the name of the external index file to create if you select the
create external index file option. You can use an external index file 
when saving records via the Save Data Command 

Operations
Create Index This operation allows you to create either an internal or external 

index. The Internal Index option creates a new index within the 
specified Btrieve file.    The External Index option creates an external 
index file based upon the specified Btrieve file. For either option, the 
description of the new key will be taken from one of the the key 
specifications currently defined in the Information Editor 

Drop Index This operation allows you to drop a Btrieve index. Select the 
renumber option if you want Btrieve to decrement the number of each
sequentially-numbered key greater than the key being dropped.

Key Lists
Editor This list contains all key numbers currently specified in the Key 

Selection Controls    of the Information Editor. This list is enabled only 
on the create operations. The key specification number selected will 



be used when creating either an internal or an external index.

Btrieve Available This list contains all key numbers which are not currently being used 
by the specified Btrieve file. This list is enabled only when creating an 
internal index. The key number selected will be used when creating 
the internal index.

Btrieve existing This list contains all existing key numbers in the specified Btrieve file. 
This list is enabled only when dropping an index. The key number 
selected will be the one dropped.

Buttons
Refresh / Execute Once the user has specified the name of an existing Btrieve file, the 

refresh lists button is used to update the Btrieve available and existing
keys lists. The user can then select the operation and the appropriate 
key numbers from the list(s) and execute the operation.

Cancel / Close Select this button to close the dialog. After the first create or drop 
index operation has occurred, the cancel changes to a close, 
signifying that you cannot undo any completed operations.

Related topics
Adding an index to a Btrieve file 
Dropping an index from a Btrieve file 
Creating an external index 



Set / Clear Owner Dialog

This dialog allows the user to set or clear an owner name from an existing Btrieve file.    Below is a 
description of each of the dialog's controls.

Btrieve File Name Specify the name of the Btrieve file here.

Clear Owner Select this option to clear an owner name from the Btrieve file.

Current Owner Used with the clear owner operation to specify the current owner name in
the Btrieve file.

Set Owner Select this option to set a new owner name for the Btrieve file.

New Owner Used with the set owner operation to specify the new owner name ifor the
Btrieve file.

Permit RO Access When checked    with the set owner operation, Btrieve will allow users to 
access the file in read-only mode without specifying the owner name.

Encrypt Data When checked with the set owner operation, Btrieve will encrypts all data
in the file.

Cancel / Close Select this button to close the dialog. After the first create or drop index 
operation has occurred, the cancel changes to a close, signifying that you
cannot undo any completed operations.

Related topics
Setting an owner name 
Clearing an owner name 



Copy Data Dialog

This dialog allows the user to copy data from one Btrieve file to another Btrieve file.    Below is a 
description of each of the dialog's controls.

From Btrieve File Specifies the name of the Btrieve file from which the data is to be copied.

To Btrieve File Specifies the name of the Btrieve file to which the data is to be copied.

Browse Buttons Displays a Browse File Dialog . The selected file name will be placed in 
the corresponding file name edit control. 

Background When checked, the data will be copied in the background while you can 
continue working within the Btrieve File Manager.

Ok Button The dialog is closed and the copy operation is initiated.

Cancel Button The dialog is closed and the copy operation is aborted

Related topics
Copying data from one file to another



Load Data Dialog

This dialog allows the user to load data from an unformatted sequential file to a Btrieve file.    Below is a 
description of each of the dialog's controls.

From Sequential File Specifies the name of the unformatted sequential file from which the 
data is to be copied. Refer to the Btrieve for Windows Installation and 
Operation Manual for instructions on how to properly format a sequential
file.

To Btrieve File Specifies the name of the Btrieve file to which the data is to be copied.

Browse Buttons Displays a Browse File Dialog . The selected file name will be placed in 
the corresponding file name edit control. 

Background When checked, the data will be loaded in the background while you can 
continue working within the Btrieve File Manager.

Ok Button The dialog is closed and the load operation is initiated.

Cancel Button The dialog is closed and the load operation is aborted

Related topics
Loading data into a Btrieve    file 



Save / Recover Data Dialog

This dialog allows the user to save data from a Btrieve file to an unformatted sequential file.      Below is a 
description of each of the dialog's controls.

File Names
Btrieve File Specifies the name of an existing Btrieve file.

Sequential File Specifies the name of the sequential file to create. Refer to the 
Btrieve for Windows Installation and Operation Manual for instructions
on how to properly format a sequential file.

External Index File Specifies the name of the external index file used to sort the records 
being saved from the Btrieve file. You can create an external index file
using the Create Drop Index Command 

Options
Use An Index
 

When checked, the Btrieve File Manager will save the data sorted by 
either an internal index or an external index file.

Internal When selected, a list of all keys currently defined in the specified 
Btrieve file will be displayed.    Use the Refresh Button to update 
this list if you change the name of the Btrieve file. Select the key 
number to use when saving the records from this list.

External File When selected, an edit control for specifying the name of the 
existing external index file will be displayed. 

Don't Use An Index When checked, the Btrieve File Manager will save the data unsorted 
as it is stored in the file. Use this option if you want to recover data 
from a file whose index(es) may be corrupted.

Background When checked, the data will be saved in the background while you 
can continue working within the Btrieve File Manager.

Buttons
Execute
 

Once all required information has been entered, selecting this button 
will perform the specified save operation.

Cancel Selecting this button will close the dialog.

Related topics
Saving data without an index 
Saving data using an internal index 
Saving data file using an external index 



Browse File Dialog

This standard file browse dialog allows the user to select the name of an existing file.    Below is a 
description of each of the dialog's controls.

File Name Specifies the selected file name.

File List Displays list of files in current directory corresponding to search 
pattern in file name control.

Directories Displays the current working directory.

Directories List Displays hierarchical view of directory structure.

Drive List Allows user to change current drive letter.

Ok Button Closes dialog and returns the specified file name to the applications.

Cancel Button Closes the dialog without returning a file name.

Get OwnerName Dialog

This dialog allows the user to enter the owner name of an existing Btrieve file. It is displayed whenever 
the Btrieve File Manager is unable to open a Btrieve file because it has an owner name. Below is a 
description of each of the dialog's controls.

Btrieve File Name Displays the name of the Btrieve file being opened.

Owner Name Specifies the owner name needed to open the file.

Ok Button Closes the dialog and attempts to open the Btrieve file with the 
specified owner name. If the owner name is invalid, this dialog will be 
redisplayed.

Cancel Button Closes the dialog and aborts the open operation.

ACS Info Dialog

This dialog allows the user to enter alternate collating sequence (ACS) information for a particular key 
specification.    Below is a description of each of the dialog's controls.

ACS / Country Code When selected, Btrieve will use the specified country ID and code 
page when sorting this key.

Country ID The country ID. A value of -1 indicates the system default.

Code Page The code page. A value of -1 indicates the system default.

ACS File When selected, Btrieve will use the ACS defined in the specified file 
when sorting this key.

ACS File Name Specifies the ACS file name. The ACS file must be formatted in 



accordance with the specification defined in the Btrieve 
Programmer's Manual.

Browse Button Displays a Browse File Dialog . The selected file name will be 
placed in the ACS File Name control. 

Ok Button Closes the dialog and saves any changes to the ACS information.

Cancel Button Closes the dialog and does not save any changes.

Description File Comments Dialog

This dialog allows the user to enter, edit, or view description file comments.      Below is a description of 
each of the dialog's controls.

Description Edit Control A standard multiline edit control. Enter the comment you wish to 
save to the top of the description file here.

Ok Button Closes dialog and saves any changes.

Cancel Button Closes the dialog and does not save any changes.

About Dialog

This dialog displays information regarding the current software versions loaded and system status.    
Below is a description of each of the dialog's controls.

Btrieve File Manager Information Version
Copyright

Btrieve Status Client engine status and version (if loaded)
Requestor status and version (if loaded)

Windows System Status Mode
Available memory
Math coprocessor
Disk space

Ok Button Closes the dialog

New Command

This command allows you to either open the Information Editor Window    with the default settings or to 
clear existing information in the editor to the default settings. If the information in the editor has changed 
since the last time it was saved, the Save Current Information dialog will appear, giving the user a chance 
to save the current information to a file before continuing.



Close Command

This command allows you to close the    Information Editor Window If the information in the editor has 
changed since the last time it was saved, the Save Current Information dialog will appear, giving the user 
a chance to save the current information to a file before continuing.



Open Command

This command allows you to load Btrieve file / key information into the Information Editor from an existing 
Btrieve or description file. When you choose this command,    the Btrieve File Manager displays the Open 
File Dialog 



Create Command

This command allows you to create a new Btrieve or description file using the file / key information 
currently in the Information Editor.    If the Editor information includes a current file name and type, the 
Btrieve File Manager will attempt to create a new file using this name and type. If there is no current file 
name and type,    the Btrieve File Manager displays the Create As Dialog 



CreateAs Command

This command allows you to create a new Btrieve or description file using the file / key information 
currently in the Information Editor.    When you choose this command, the Btrieve File Manager displays 
the CreateAs File Dialog 



Set / Clear Command

This command allows you set or clear an owner name from a Btrieve file. When you choose this 
command,    the Btrieve File Manager displays the Set / Clear Owner Name Dialog 



Create / Drop Command

This command allows you add or drop indexes from a Btrieve file or to create an external index.    When 
you choose this command,    the Btrieve File Manager displays the Create / Drop Index Dialog 



Copy Command

This command allows you to copy data from one Btrieve file to another Btrieve file. When you choose this 
command,    the Btrieve File Manager displays the Copy Data Dialog 



Load Command

This command allows you to load data from an unformatted sequential file to a    Btrieve file. When you 
choose this command,    the Btrieve File Manager displays the Load Data Dialog 



Save Command
This command allows you to save data from a Btrieve file to an unformatted sequential file. When you 
choose this command,    the Btrieve File Manager displays the Save Data Dialog 



Getting File Manager Help Command

This command brings up the the Windows Help system and displays the methods for getting context 
sensitive help.

Related topics
Getting Help



About Help Command

This command allows you to see information related to the current software versions and the system 
status. When you choose this command,    the Btrieve File Manager displays the About Dialog 



Menu Options
The Btrieve file manager provides the following menu options:

File Menu Manipulate Btrieve and description files
Index Menu Add and drop Btrieve indexes
Data Menu Manipulate Btrieve data
Help Menu Get help



Dialog Boxes
File Dialogs Open File 

Create As 
Save Report 
File Browse 

Btrieve Operation Dialogs Create / Drop Index 
Set / Clear Owner Name 

Data Manipulation Dialogs Copy Data 
Load Data 
Save Data 

Miscellaneous Dialogs Get Owner Name 
Alternate Collating Sequence Information 
Description File Comments 
About 

Common Operations
This section describes a number of standard operations a user might want to perform with the Btrieve File
Manager. The operations have been grouped into several categories.

Information Editor Opening 
Loading Information 
Creating a file using the current editor information

Creating A Btrieve File From scratch 
With the same attributes as an existing Btrieve file    
Similar to an existing Btrieve file 
Using a description file 

Creating Other Types of Files Description file 
Report file 

Creating / Dropping Indexes Adding an index to a Btrieve file 
Dropping an index from a Btrieve file 
Creating an external index 

Manipulating Data Loading data into a Btrieve    file 
Saving data without an index 
Saving data using an internal index 
Saving data file using an external index 
Copying data from one file to another

Owner Names Setting an owner name 
Clearing an owner name 



Exit Command
This command exits the Btrieve File Manager. If the information in the editor has changed since the last 
time it was saved, the Save Current Information dialog will appear, giving the user a chance to save the 
current information to a file before continuing.



Save Current Information
This dialog is displayed whenever the the user attempts to perform an operation which will overwrite 
existing information in the Information Editor which has not yet been saved. The user will have three 
options when asked whether he wants to save the file before continuing with the operation.

Yes The Create As Dialog    will be    displayed, allowing the user to create a new 
Btrieve or description file using the current information. After the new file is 
created, the operation will be processed.

No The existing information will be destroyed and the operation will be processed.

Cancel The operation will be aborted.

File Specification 
Below is a description of each of the controls used to define the file specification of a Btrieve file.    These 
controls correspond to the various file attributes Btrieve supports when creating a Btrieve file.    For more 
information about these controls and their associated Btrieve attributes, refer to the Btrieve for Windows 
Installation and Operation Manual or the Btrieve Programmer's Manual.

Available Linked Keys  This specifies how many unused 8-byte key placeholders will be 
available at the end of each record for supplemental linked-
duplicatable keys. These placeholders enable you to add new 
keys to a file that uses the linked-duplicatable method of storing 
duplicatable keys.

Balanced Indexing When checked, Btrieve will look for available space in sibling 
index pages each time an index page becomes full and then 
rotates values from the full page onto th pages with space 
available.

Blank Truncation When checked, Btrieve will perform blank truncation on variable-
length records.

Data Compression When checked, Btrieve compresses the file's records before 
inserting or updating them, and uncompresses the records when 
it retrieves them.

Key Only When checked, Btrieve creates a key-only file. This type of file 
contains no data and includes only on key (index).

# Keys This control indicates how many different key specifications are 
currently defined in the Information Editor.

# Segments This control indicates how many different key segment 
specifications are currently defined in the Information Editor.

Page Size This control specifies the page size Btrieve will use when creating
a file.

Pre-allocation Btrieve typically creates a new file with the minimum number of 
pages needed to support the various file and key attributes 
specified. When this control is checked, the user may specify up 
to 65,535 pages in the # Pages control.



# Pages This control specifies how many pages Btrieve should preallocate
when creating a new file.

% Free Space This control specifies the percentage of space you want Btrieve to
reserve on each variable page to allow for future expansion 
variable records. This allows the user to reduce the amount of 
fragmentation of variable records across several pages.

Record Length This control specifies the logical length of the fixed portion of the 
data record.

Variable Records When checked, Btrieve creates a file which allows variable 
records (records longer than the fixed length).

VATs When checked, Btrieve includes Variable-tail Allocation Tables 
(VATs) in the file. VATs are used by Btrieve to accelerate random 
access to the variable-length portions of records, but also to limit 
the size of the compression buuffer used during data 
compression.

Key Specification 
The controls used to specify the the key attributes supported by Btrieve are located at the bottom of the 
Information Editor Window. The controls have been divided into three groups. For more information about 
these controls and their associated Btrieve attributes, refer to the Btrieve for Windows Installation and 
Operation Manual or the Btrieve Programmer's Manual.

Key Selection Lists These lists are located at the center of the key specification area.
They allow the user to add or delete key specifications from the 
Information Editor as well as change the current specification 
being viewed. 

Key Group Box This group box is located at the left of the key specification area. 
The group box's controls specify information common to ALL 
segments of the current key. 

Key Segment Group Box This group box is located at the right of the key specification 
area. The group box's controls specify information about a 
particular segment of the current key. 

Key Selection Lists
These lists allow the user to add or delete key specifications from the Information Editor as well as 
change the current specification being viewed. 

Key Selection List This list contains all key numbers currently defined in the 
Information Editor. As the user scrolls through this list, the key
information corresponding to the key number is displayed in 
the editor. The three buttons beneath the control allow the 
user to manipulate the key numbers in the list.

Insert Key Button This button inserts a new key number after the one currently 
selected. If there is key at this position already, that key (and 



all subsequent consecutive keys) will be incremented by one.

Delete Key Button This button deletes the currently selected key. Subsequent 
keys are not renumbered. This button is shown only when a 
key is currently selected in the key selection list.

Compress Key Button This button renumbers all key numbers in the list 
consecutively starting with 0. This button is shown only when 
there are holes in the list of key numbers.

Key Segment Selection List This list contains all key segment numbers defined for the 
currently selected key. As the user scrolls through this list, the
key segment information corresponding to the segment 
number is displayed in the editor. The two buttons beneath 
the control allow the user to manipulate the key segment 
numbers in the list.

Insert Segment Button This button inserts a new key segment number after the one 
currently selected. If there is segment at this position already, 
that segment (and all subsequent segments) will be 
incremented by one.

Delete Segment Button This button deletes the currently selected segment. If this is 
the last segment for the current key, the entire key is deleted. 
Subsequent keys are renumbered. This button is shown only 
when a segment is currently selected in the key segment 
selection list.

Key Group Box
The controls in this group box specify information common to ALL segments of the current key. 

ACS Information This button displays the ACS Information Dialog This dialog allows the 
user to specify an alternate collating sequence used in sorting the 
current key. Any segment of this key which uses an ACS will use the 
ACS specified here.This button is only enabled if the Use ACS control 
in the Segment Group Box is checked.

Duplicates When checked, Btrieve allows more than one record in the file to 
contain the same value for this key field.

Modifiable When checked, Btrieve allows a key value for this key field to be 
updated.

Null Key This control specifies whether the key has a null value. You can use a 
null value in a key when the data for the key is unavailable or when 
you do not want Btrieve to include a record for that key in the index. 
Btrieve supports two methods for determining whether a particular key 
value is a null value. These methods vary only for multi-segment keys.

Any Segment When selected, Btrieve treats a key value as null if ANY segment of the
key contains a null value. 

All Segments When selected, Btrieve treats a key value as null only if ALL segments 
of the key contain a null value.



Repeating Duplicates Btrieve supports two methods of storing duplicate values for a key, 
repeating duplicates and linked duplicates. When checked, Btrieve 
uses the repeating duplicates method. 

Unique Values This is a read-only control specifying the number of unique key values 
contained by this key in a recently-opened Btrieve file. NA is displayed 
if the current editor information was not loaded from an existing Btrieve
file.

Key Segment Group Box
The controls in this group box specify information about a particular segment of the current key. 

Case Insensitive When checked, Btrieve sorts this segment without regard to case. I.E., 
the characters 'a' and 'A' will be given the same ordinal values. This 
control is only enabled if the data type of the segment is string, zstring, or
lstring.

Data Type This control specifies the Btrieve data type for the key. The data type 
determines how Btrieve will sort the bytes specified for this key segment.

Descending When checked, Btrieve will collate the key segment in descending sort 
order.

Key Length This control specifies the length of the key segment field.

Key Position This control specifies the starting offset (1 relative) of the current key 
segment.

Null Value (Hex) This control specifies the null value Btrieve should use when determining 
whether a key value should be treated as null or not. This control is 
enabled only if the Null Key control was checked for this key.

Use ACS When checked, Btrieve expects an ACS to be specified for this segment. 
Use the ACS Information Dialog    to specify the ACS for this key. All 
segments of a particular key do not need to use an ACS; however, all 
that do use an ACS must use the same one.

Creating a Btrieve file from scratch
Following are the steps needed to create a new Btrieve file without using an existing Btrieve or description
file.

1.    Select the New command    from the File Menu. This will open the Information Editor Window if it is 
currently closed or refresh the editor contents if it is open.

2.    Enter the desired Btrieve file and key specification information in the editor. 

3.    Create a new Btrieve file  using the information currently in the Information Editor.



Creating a clone of an existing Btrieve file 
Following are the steps needed to create a new Btrieve file with the same file and key attributes as an 
existing Btrieve file.

1.    Load the file and key information from an existing Btrieve file.

2.    Create a new Btrieve file  using the information currently in the Information Editor.



Creating a Btrieve file similar to an existing Btrieve file
Following are the steps needed to create a new Btrieve file whose file and key attributes are similar to 
those of an existing Btrieve file.

1.    Load the file and key information from an existing Btrieve file.

2.    Make the desired changes to the file and key information.

3.    Create a new Btrieve file  using the information currently in the Information Editor.



Creating a description file
Developers have often found it useful to store the file and key specifications for their Btrieve files in 
description files. While the user can still create and edit description files with a standard text editor, the 
Btrieve File Manager makes this process much easier. Following are the steps needed to create a 
description file.

1. Load the file and key information from an existing Btrieve or description file into the Information Editor.

2.    Create a new file  using the information currently in the Information Editor. Specify description as the 
file type in the CreateAs File Dialog 



Creating a Btrieve file using a description file
Following are the steps needed to create a new Btrieve file using the file and key specifications defined in 
an existing description file.

1.    Load the file and key information from an existing description file.

2.    Create a new file  using the information currently in the Information Editor. Specify Btrieve as the file 
type in the CreateAs dialog 



Creating a report file
Following are the steps needed to create a report file based upon the information in the Information 
Editor.

1.    Load the file and key information from an existing Btrieve or description file. You can also enter 
information into the editor using the defaults as a base.

2. Make the desired changes to the file and key information.

3. Select the Stat Report... button in the Information Editor. The Save Report Dialog will be displayed. 
Enter the name of the report file, select Ok, and a new report file with the current editor information will 
be created.



Adding an index to a Btrieve file
Following are the steps needed to add an index to an existing Btrieve file.

1.    Open the Information Editor 

2.    Enter at least one key specification either manually or by Loading Information into the Information 
Editor 

3.    Select the Create / Drop command from the Index menu. The Create / Drop Index Dialog will be 
displayed.

4.    Select the Create Index option. Then select the Internal Index option. 

5.    Enter the Btrieve file name you want to add the index to. Update the Btrieve available and existing 
lists by selecting the Refresh button. 

6.    Select the number from the editor list of the key specification you want to use to define the new index.
Select the desired key number from the Btrieve available list.

7.    Select Execute. The new index will be added to the specified Btrieve file. The Btrieve available and 
existing lists will be updated.



Dropping an index from a Btrieve file
Following are the steps needed to drop an index from an existing Btrieve file.

1.    Select the Create / Drop command from the Index menu. The Create / Drop Index Dialog will be 
displayed.

2.    Select the Drop Index option. If you want Btrieve to renumber the keys after the key being dropped, 
select the Renumber option.

3.    Enter the Btrieve file name you want to drop the index from. Update the Btrieve available and existing 
lists by selecting the Refresh button. 

4.    Select the number from the Btrieve existing list of the key you want to drop.

5.    Select Execute. The index will be dropped. The Btrieve available and existing lists will be updated.



Creating an external index
Following are the steps needed to create an index using an existing Btrieve file. Once created, an 
external index file can be used to save information using the Save command 

1.    Open the Information Editor 

2.    Enter at least one key specification either manually or by Loading Information into the Information 
Editor 

3.    Select the Create / Drop command from the Index menu. The Create / Drop Index Dialog will be 
displayed.

4.    Select the Create Index option. Then select the External Index option. 

5.    Enter the Btrieve file name you want to use to create the external index. Update the Btrieve available 
and existing lists by selecting the Refresh button. 

6.    Enter the name of the external index file you want to create. 

7.    Select the number from the editor list of the key specification you want to use to define the external 
index. 

8.    Select Execute. The external index file will be created using the selected key specification.



Loading data into a Btrieve    file
Following are the steps needed to load data from an unformatted sequential file into an existing Btrieve 
file.

1.    Select the Load command from the Data menu. The Load Data Dialog will be displayed.

2.    Enter the name of the sequential file which contains the data to be loaded. 

3.    Enter the name of the Btrieve file into which the data will be loaded.

4.    If you want to execute the load operation in the background, select the Background option. 

5.    Select Execute. A dialog will be displayed showing the progress ( number and percentage of records 
processed ) of the operation. 



Saving data without an index
Following are the steps needed to save data from an existing Btrieve file to an unformatted sequential file 
without using an index. The records will be saved in sequential order as they appear in the file.

1.    Select the Save command from the Data menu. The Save Data Dialog will be displayed.

2.    Enter the name of the Btrieve file which contains the records to be saved.

3.    Enter the name of the sequential file to which you want to save the data.

4.    Turn off the Use An Index option. 

5.    If you want to execute the save operation in the background, select the Background option. 

6.    Select Execute. A dialog will be displayed showing the progress ( number and percentage of records 
processed ) of the operation. 



Saving data using an internal index
Following are the steps needed to save data from an existing Btrieve file to an unformatted sequential file 
using an internal index.

1.    Select the Save command from the Data menu. The Save Data Dialog will be displayed.

2.    Enter the name of the Btrieve file which contains the records to be saved.

3.    Enter the name of the sequential file to which you want to save the data.

4.    Select the Use An Index option. 

5.    Select the Internal Index # option. A list box will be displayed showing all existing indexes in the 
Btrieve file (press the refresh button if the Btrieve file name is modified). Select the key number by 
which you want to save the records.

6.    If you want to execute the save operation in the background, select the Background option. 

7.    Select Execute. A dialog will be displayed showing the progress ( number and percentage of records 
processed ) of the operation. 



Saving data file using an external index
Following are the steps needed to save data from an existing Btrieve file to an unformatted sequential file 
using an existing external index file. External index files can be created using the Create / Drop Index 
command 

1.    Select the Save command from the Data menu. The Save Data Dialog will be displayed.

2.    Enter the name of the Btrieve file which contains the records to be saved.

3.    Enter the name of the sequential file to which you want to save the data.

4.    Select the Use An Index option. 

5.    Select the External Index option. An edit control will be displayed for entering the name of the existing 
external index file to use. Make sure that the Btrieve file has not been updated since this file was 
created.

6.    If you want to execute the save operation in the background, select the Background option. 

7.    Select Execute. A dialog will be displayed showing the progress ( number and percentage of records 
processed ) of the operation. 



Setting an owner name
Following are the steps needed to set the owner name of an existing Btrieve file.

1.    Select the Set / Clear Owner Name command from the Data menu. The Set / Clear Owner Name 
Dialog    will be displayed.

2.    Enter the name of the Btrieve file to which you want to set an owner name.

3.    Select the Set Owner Option.

4.    Enter the owner name (up to 8 characters) in the owner name control. The characters will be 
displayed as asterisks for security.

5.    Checking the permit read-only access option will cause Btrieve to allow users to open the file    in read
only mode even if they haven't specified an owner name.

6.    Checking the encrypt data option will cause Btrieve to encrypt all data inserted into the file. 

7.    Select Execute to complete the set owner operation.



Clearing an owner name
Following are the steps needed to drop the owner name of an existing Btrieve file.

1.    Select the Set / Clear Owner Name command from the Data menu. The Set / Clear Owner Name 
Dialog    will be displayed.

2.    Enter the name of the Btrieve file to which you want to clear the owner name.

3.    Select the Clear Owner Option.

4.    Enter the current owner name (up to 8 characters) in the owner name control. The characters will be 
displayed as asterisks for security.

5.    Select Execute to complete the set owner operation.



Loading Information into the Information Editor
When the Information Editor Window is first opened, default file and key information is displayed. The 
user may wish to start editing the information using these defaults as a base. In many cases, however, it 
may be easier to use the file and key specifications already defined in an existing Btrieve or description 
file as a starting point.
Following are the steps needed to load information from an existing file into the Information Editor.

1.    Select the Open command from the File Menu. This will display the Open File dialog. 

1.    Select    the existing Btrieve or description file and press Ok. The Btrieve File Manager will open the 
Information Editor Window (if it is not currently open) and display all of the file's file and key 
specification information in the editor.



Creating a new file with the editor information
When the user is finished specifying file and key specifications in the Information Editor Window    he may 
save the information to either a Btrieve file or a description file. Following are the steps needed to save 
information from the Information Editor to a new file.

1.    Select the CreateAs command from the File Menu. The CreateAs Dialog will be displayed. 

2.    Enter the name of the Btrieve or description file you wish to create. Select either Btrieve or description
as the file type. Select Ok.

3.    If a file by the given name already exists, the user will be asked if he wants to continue with the 
create, enter a new file name, or cancel the create operations. If the existing file is a Btrieve file, the 
user will also be informed of the number of records contained within the file. If the user continues with 
the operation, a new Btrieve or description file will be created using the current editor information.



Opening the Information Editor
The Information Editor Window    can be opened in two ways. Selecting the New command    from the File 
menu will open the editor using default values. Selecting an existing Btrieve or description file using the 
Open command    from the File menu will open the editor and display the file and key information of that 
file.



Background option
The Btrieve File Manager supports performing potentially time-consuming tasks in the background. This 
allows the user to start one or more long operations and continue doing other tasks in the foreground 
uninterrupted. The operations which can be performed in the background include Create Index, Load 
Data, Copy Data, and Save Data. If the background option is selected a new task will be initiated to 
perform the operation. The user can switch to this task at any point and observe it's progress. When the 
operation is completed, the icon for the background task will blink. 



Copying data from one file to another
Following are the steps needed to copy data from one Btrieve file to another.

1.    Select the Copy command from the Data menu. The Copy Data Dialog will be displayed.

2.    Enter the name of the Btrieve file which contains the records to be copied.

3.    Enter the name of the Btrieve file into which the data will be copied. Make sure that this file has a 
format compatible with that of the source Btrieve file.

4.    If you want to execute the load operation in the background, select the Background option. 

5.    Select Execute. A dialog will displayed showing the progress ( number and percentage of records 
processed ) of the operation. 



Miscellaneous File Information
Below is a description of each of the miscellaneous controls. For more information about these controls 
and their associated Btrieve attributes, refer to the Btrieve for Windows Installation and Operations 
Manual or the Btrieve Programmer's Manual.

File Type This read-only control displays the file type (Btrieve or description) 
last opened or created. 

Version If the last file opened or created was a Btrieve file, this read-only 
control displays the file's version. The version does NOT always 
indicate the version of Btrieve used to create the file. Rather, it 
indicates the earliest version of Btrieve which supports all of the 
attributes of this file. For example, a file created by Btrieve version 
6.1 which doesn't have any version 6.1 specific attributes will have a 
file version of 6.0 (Btrieve version 5.x does not support the new 
format of version 6.x). If the last file accessed was not a Btrieve file, 
NA is displayed.

Total Records If the last file opened or created was a Btrieve file, this read-only 
control displays the number of records in the file. If the last file 
accessed was not a Btrieve file, NA is displayed.

Btrieve Owner Name The user can enter up to 8 characters in this edit control. After 
creating a new Btrieve file using the current information in the editor, 
the Btrieve File Manager will set the owner of the file to this value.

Description Comments... This button displays the Description Comments dialog This dialog is 
used to edit comments stored in description files.

Stat Report... This button displays the Save Report Dialog    This dialog is used to 
save a statistics report based upon the current information in the 
editor.

Show 6.x Info This button is only displayed after a pre-version 6.x Btrieve file has 
been loaded or created. In this case, all controls specific to version 
6.0 and above are hidden. Pressing this button will re-display all of 
these controls.



Repeating Duplicates
Selecting this method of storing duplicate key values causes Btrieve to store every duplicate value for a 
key on both a data page and an index page. 



Linked Duplicates
This method of storing duplicate values causes Btrieve to store only unique key values for a key in the 
index pages. Duplicate values are stored as part of a linked list in the data pages. This method requires 
that space be reserved on the data pages at the time the file is created. Use the Available Linked Keys 
control in the File Specification section to specify how much space to reserve for future linked-
duplicatable keys in the future. 



Getting Help
For context-sensitive help at any time while you are running the Btrieve File Manager, you can use one of 
two methods:

Help Menu Select the Help option from the menu bar at the top of the File Manager window.

Help Key Press the F1 function key. This key produces help information about the highlighted menu
command or current window or dialog box.



How to use MS Windows Help Command
This command brings up the MS Windows help system with an explanation of how to use the system's 
different features.



Help Index Command
This command brings up the MS Windows help system with an index to the Btrieve File Manager help file.

Related topics
Help Index 




